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HCT 9.6 AC97 Based Modem/Analog

Windows Me

Step By Step Instructions

Welcome to the AC97 Based Modem/Analog Test Procedures for Microsoft( Windows( Millennium Edition, operating systems. This procedure is specifically oriented towards analog/PSTN modems that are attached to the PCI Core Logic chipset by means of the AC-Link. Do not use this document to test either server machine oriented modems or wireless devices that are similar to modems. 

This document provides some of the information you need to assemble your test submission. Please click the How to Logo a Device or System link on the Windows Hardware Quality Lab web site: http://www.microsoft.com/hwtest for the following important process information and document downloads:

· Program Help Aliases

· Windows Logo Information

· Required Legal Agreements

· Self-Test Audit Program Guidelines

· Authorized Test Sites and Shipping Information

· Testing Time Lines

· Testing Fee and Payment Information

Select the Type of Test Submission

 FORMCHECKBOX 




Initial test run

 FORMCHECKBOX 




Initial test run of a derivative modem


 FORMCHECKBOX 




Retest of a previously failed submission

 FORMCHECKBOX 




Driver update of a previously logo’d device/driver combination

 FORMCHECKBOX 

Localized driver package for previously logo'd submission 
To pretest your product

 FORMCHECKBOX 




To pretest your product, complete the Presubmission Test Procedures

To assemble the test submission

You must include the following information in your test submission, before you can begin hardware compatibility testing.

 FORMCHECKBOX 








Six (6) test modems

 FORMCHECKBOX 








Two (2) Systems 

 FORMCHECKBOX 








Unusual or specialized hardware required for testing your product and its features
This hardware includes phone/jack cable splitters, dongles, and any cables to connect to cellular phones.
Note:
WHQL does not return these devices to you upon test completion.

 FORMCHECKBOX 








End-user manuals 
You must include Modem Command Set documentation in English. WHQL accepts draft.

 FORMCHECKBOX 








Device driver(s) 

 FORMCHECKBOX 








.INF file

 FORMCHECKBOX 








Utilities, if any, included on diskette

 FORMCHECKBOX 




Driver update delta change sheet from previously logo’d driver (driver update submissions only)

 FORMCHECKBOX 

A complete, electronic copy of this document

formcheckbox 










Multifunction devices: 
If your product implements more than one functionally independent, logical device, you must test each device with its corresponding WHQL Test Kit. To submit a multifunction device you must include the following:

formcheckbox 










A complete electronic copy of the test procedures document for each logical device function 

formcheckbox 










A complete electronic copy of the multifunction device supplement (Multif.doc)

 FORMCHECKBOX 

A complete and signed "WHQL Testing and Quick-Sign Agreement", "Driver Distribution Agreement", and "Logo License Agreement" (unless already on file at WHQL)

 FORMCHECKBOX 




A complete and signed “Exhibit A”

 FORMCHECKBOX 

Payment
Include a printed copy of the USA Payment Form, Wire Transfer, or Purchase Order, if applicable. 

Localized Modem Drivers

Check off all languages in the localization table, for which you provide localized drivers with this test submission.  WHQL digitally signs drivers of all language versions for driver distribution. WHQL does not charge for localized drivers included with your initial test submission. Localized drivers not included with your test submission, require an additional processing fee for each package of localized drivers, regardless of the number of localized drivers provided in each package. WHQL does not require you to provide test logs. 
1. If only the INF(s) and no binary files change to support localization, then please provide the following information: 

· Full submission for English version including fees, logs, and so forth. 

· All different language versions of INF files.

· A list detailing the changes to the additional language INF files.

· A list that describes which INF files support what languages. 

· A complete copy of the localization table, in the following section, for each additional language INF.

Note:
WHQL tests the English version. WHQL may also test localized versions of the drivers on a 
case-by-case basis, and WHQL expects these localized drivers to pass testing.

2. If one set of driver binaries and INFs works in many countries, then please provide the following information:

· Full submission for that driver set

· Complete the table in the information form that states which countries the board and driver set operate in

· A complete copy of the localization table provided in the following section

· WHQL tests that one driver set against the following countries using a TAS phone line simulator: 

· US English

· France

· Germany

· Italy 

· Japan

· Spain 

Note:
After all of the previous countries pass testing with the provided PC boards, WHQL expects that any additional countries supported by that combination of that revision of the driver set successfully combines with that PC board revision. WHQL reserves the right to also test those other countries on a case-by-case basis, and expects them to pass testing.

3. Binary files change to support operation in different countries, or to display localized text. 
Each different set of binaries requires a separate submission for each version of the driver.

Localization Table

Include these localized files to confirm that you have tested the drivers, and the drivers operate properly on the respective localized versions of the Windows operating systems.

	 FORMCHECKBOX 
  Arabic
	 FORMCHECKBOX 
  Finnish
	 FORMCHECKBOX 
  Polish

	 FORMCHECKBOX 
  Basque
	 FORMCHECKBOX 
  French
	 FORMCHECKBOX 
  Portuguese

	 FORMCHECKBOX 
  Brazilian
	 FORMCHECKBOX 
  French Canadian
	 FORMCHECKBOX 
  Russian

	 FORMCHECKBOX 
  Catalan
	 FORMCHECKBOX 
  German
	 FORMCHECKBOX 
  Slovak

	 FORMCHECKBOX 
  Chinese-Simplified
	 FORMCHECKBOX 
  Greek
	 FORMCHECKBOX 
  Slovenian

	 FORMCHECKBOX 
  Chinese-Traditional
	 FORMCHECKBOX 
  Hebrew
	 FORMCHECKBOX 
  Spanish

	 FORMCHECKBOX 
  Czech
	 FORMCHECKBOX 
  Hungarian
	 FORMCHECKBOX 
  Swedish

	 FORMCHECKBOX 
  Danish
	 FORMCHECKBOX 
  Italian
	 FORMCHECKBOX 
  Thai

	 FORMCHECKBOX 
  Dutch
	 FORMCHECKBOX 
  Japanese
	 FORMCHECKBOX 
  Turkish

	 FORMCHECKBOX 
  English
	 FORMCHECKBOX 
  Korean
	Other:      

	 FORMCHECKBOX 
  English-Euro
	 FORMCHECKBOX 
  Norwegian
	


Contact Information

Company listed on the HCL

	Company Name:
	ASUSTeK Computer Inc. 

	Web Address:
	www.asus.com.tw


Technical Contact

	Name:
	Jimmy Juang

	Company Name:
	ASUSTeK Computer Inc.

	Address:
	No.150, Li-Te Rd., Peitou

	City:
	Taipei

	State/Province
	Taiwan

	ZIP Code:
	112

	Country:
	R.O.C.

	Phone Number:
	886-2-2894-3447x3062

	FAX Number:
	886-2-2895-0113

	E-mail:
	jimmy_juang@asus.com.tw


Marketing Contact

	Name:
	Jimmy Chung

	Company Name:
	ASUSTeK Computer Inc. 

	Address:
	No.150, Li-Te Rd., Peitou

	City:
	Taipei     


	State/Province
	Taiwan

	ZIP Code:
	112

	Country:
	R.O.C.

	Phone Number:
	886-2-2894-3447x7863

	FAX Number:
	886-2-2890-7764

	E-mail:
	jimmy_chung@asus.com.tw


Device Information

	Device Information
	OS and Hardware Information
	Process Description

	Product Name (required):
	HSP56 MR

	As you want it to appear on the HCL**.

	Announce Date (required):
	03/15/2001

	

	Complete AT Command Set included:
	 FORMDROPDOWN 




	Have you included the complete AT command set reference with all voice features and result codes?

	Reference Design Master ID (if this is a derivative modem):
	     
	

	Hardware already at WHQL.
	 FORMCHECKBOX 




Test Hardware is already at WHQL
	

	Retest:
	     
Master ID of previously failed submission.

 FORMCHECKBOX 

Windows Me update 
	Enter serial numbers of devices to use in the following section if hardware is already at WHQL. 
Note: The Product Name of the Retest submission must match the Product Name of the original submission.

	Driver update:
	
 FORMCHECKBOX 

Windows Me update
	Serial numbers of modems to use for retest or update testing:

Tag 1 ID: 
Tag 2 ID: 
These must be physical tags that you permanently attached to each modem. 
Note: The Product Name of the Driver Update submission must match the Product Name of the original submission.

	Localized Driver Package
	     
 
Master ID of previously 
logo’d submission 
	Only if this is a Localized Driver Package submitted after your Initial submission.

	Plug and Play ID: 
Enter the Plug and Play ID that uniquely identifies your device. For example, if you have a PCI device, list the Vendor ID, Device ID, SubSystem Vendor ID, and Subsystem ID. You can copy the Plug and Play ID created by the test device from the registry key \\HKEY_LOCAL_MACHINE\…Enum\…, and then paste it into the following space.


	Registry entry: 
	PCI\VEN_8086&DEV_2446&SUBSYS_14661043


	Device Information
	OS and Hardware Information
	Process Description


	This modem is submitted for which countries?
	 FORMCHECKBOX 
  USA / Canada

 FORMCHECKBOX 
  UK

 FORMCHECKBOX 
  France

 FORMCHECKBOX 
  Germany

 FORMCHECKBOX 
  Japan

 FORMCHECKBOX 
  Italy

 FORMCHECKBOX 
  Spain

Other:      
	You can make a single test submission for multiple countries as long as you use the same physical hardware and .INF file. You can use country-specific drivers if the only differences in the drivers are truly country-specific. WHQL expects that all tests pass under all supported countries.


	Bus Type:
	 FORMDROPDOWN 

	AC97-based PC Only (see other test procedures for additional busses)

	Modem Type:
	 FORMDROPDOWN 

	Select Controller Based, Controllerless, or Software Modem 

	Modem Speed:
	 FORMDROPDOWN 

	As of July 1, 1999 all modems must support V.90. This is a connection up to 56k bits per second.

	Is this a Voice Modem?
	 FORMDROPDOWN 




	

	Modem Chipset:
	PCT2303W / PCT303A / PCT303W

	Manufacturer/Model/Revision

	Firmware:
	R2.30B2022

	Version/Date/Checksum

	Modem .INF File:
	mdmchipv.inf / pctwdm.inf

	Filename/Version/Size/Date

	Additional Remarks:
	This is a data/fax/voice initial submission

	Device/Driver/.INF

	Model Number:
	S8600/8200

	

	Serial Numbers: (required)
	Test System #1

	Each device must have a clearly labeled serial number on it. Verify that you could easily identify the actual hardware associated with a submission. This eliminates any possible confusion with other models with similar names during a resubmission or driver update.

	
	Test System #2

	

	
	
	

	
	
	

	
	     

	

	
	     

	


* 
See Refresh Guidelines for Modems at http://www.microsoft.com/hwtest/ for more information.
** 
Access the HCL at http://www.microsoft.com/hwtest/.

Device Driver Information

	Driver Information
	OS and Hardware Information
	Process Description

	Operating Systems:
	formcheckbox 









 Windows Me

	Driver Name and Version:
	R2.30B2022
Windows Me
	List your in-house driver set name and identification version.

	Driver Location: 
	 FORMDROPDOWN 

Windows Me
	If you do not have a driver, or your drivers are provided by the operating system, select (BOX).

If you have provided drivers for your device, and want them posted in the Windows Driver Library, select (WDL).

If you have provided drivers for your device, but do not want them posted on the Windows Driver Library, select (MFG).


Note:
Protect Mode Drivers (including support files)

For a Controller-less or Software modem, please list all drivers needed to work on Microsoft( Windows( Millennium Edition.

	O/S supported
	File Name
	Binary Version
	Date
	File Size

	Windows Millennium
	
	
	
	

	     
	mdmchipv.inf
	r2.30b2022
	2-11-01
	33622

	     
	pctwdm.inf
	r2.30b2022
	3-06-01
	3050

	     
	ptcounty.ini
	r2.30b2022
	2-07-01
	728

	     
	pctvoice.ex_
	r2.30b2022
	2-07-01
	22598

	     
	ptserial.sy_
	r2.30b2022
	2-07-01
	70052

	     
	ptdll16.dl_
	r2.30b2022
	2-07-01
	59136

	     
	ptdll32.dl_
	r2.30b2022
	2-07-01
	92672

	     
	pthsp.da_
	  r2.30b2022 

	3-02-01
	456

	     
	ptuninst.exe
	r2.30b2022
	2-16-01
	153088

	
	vmodem.sy_

vpctcom.sy_

vvoice.sy_

	r2.30b2022

r2.30b2022

r2.30b2022

	2-07-01

2-07-01

2-07-01

	283034

192926

29739


	   
	pctptt
	r2.30b2022
	2-07-01
	34152

	
	ptctrl.cp_
	r2.30b2022
	2-07-01
	26531

	     
	
	
	
	

	     
	
	
	
	

	
	
	
	
	

	     
	
	
	
	

	     
	
	
	
	

	     
	
	
	
	

	     
	     
	     
	     
	     


This section will be completed by WHQL

	Master ID:
	     

	Submission ID: 
	     

	Device name:
	HSP56 MR

	Product Announced: 
	 FORMCHECKBOX 





	Test Lead:
	     

	Test Technician: 
	     

	Reviewer: 
	     

	Test Start Date: 
	     

	Test Complete Date:
	     

	Test Results:
	 FORMDROPDOWN 






	Test Notes: 
	Errors – Must Fix:

Warnings – Informational:




AC97 Based Modem Testing

This test report automatically generates as you complete the test procedures sections in this document. For specific test instructions, refer to the corresponding topic in the Test Procedures section.

1.0
Windows Millennium Edition, Modem Installation


Windows detects the Plug and Play modem

Did the test modem pass all of the Plug and Play tests without errors?
Passed
2.0
Hardware Device IDs


PCI IDs from Test Modem and .INF match

Does the ID in the .INF match the ID taken from the test modem?
Passed
3.0
Windows Millennium Edition, Hardware Compatibility Test


Hardware Compatibility Tests (HCT 9.6)

4.0
Windows Millennium Edition, Remote Dial-up Network Compliance


Remote dial-up connection speed

Did the modem connect above 33.6 against the Ascend Max and 3Com I-Modem?
Passed

Cab file copy and comparison

Was the two Mini.cab copied, and are the two Mini.cab
files identical?
Passed
5.0
Windows Millennium Edition, Multilink Test 


Connection to a server with two modems

Are you connected to the server with both modems? 
Passed

Test whether either modem can connect first

Can you connect to the server with the test modem calling first? 
Passed
Can you connect to the server with the V.Everything™ modem calling first? 
Passed

Cab file copy and comparison

Was the Mini.cab copied, and are the two Mini.cab
files identical?
Passed
6.0
Windows Millennium Edition, Modem Uninstallation


Test modem uninstallation

How is the test modem removed? 
Add/Remove Programs
Are there instructions explaining how or where the modem is removed?
Passed

Modem Control Panel reflects removal of test modem

Did uninstalling the test modem remove it from the modem list?
Passed
Did the BIOS disable the modems PCI function when the riser card was removed?
Passed
7.0
Windows Millennium Edition, Upgrade to Windows 2000


Test Modem Functions after Upgrade to Windows 2000 (Professional)

Did the test modem work after you upgraded the computer to Windows 2000?
Passed
Presubmission Test Procedures

This section describes the procedures used to test your modem for Microsoft( Windows( Millennium Edition, operating systems compatibility. Please see http://www.microsoft.com/winlogo/MillLogoReq.htm for a summary of new hardware Logo Requirements for Windows Millennium Edition.
Note:
Read the latest updates to Modem FAQs at http://www.microsoft.com/hwtest/device/modem.asp, before you pretest any of your products.

To obtain a Designed for Microsoft Windows logo, and appear in future releases of the Microsoft Windows Hardware Compatibility List (HCL), a modem must meet the following requirements.

· Provide a proper Modem .INF file

· Comply with Windows Plug and Play standards and conventions

· Provide an AT compatible, TIA-602 command set

· Work with the following Windows applications

· Remote Dial-up Network

· Vendor-supplied software

· Work with the following protocols 

· 56 Kbps (V.90)

· V.42 and V.42bis

· 14.4 Kbps FAX (V.17)

· Class 1 FAX (TIA-578)

· Must pass Wake-Up-On-Ring Test 

· Modem must pass testing under Windows Millennium Edition operating system 

· Software based and Controllerless modems must meet expected installation requirements

· Modems must establish V.90 connections above 33600bps

Note:
Read the latest updates to Modem FAQ at http://www.microsoft.com/hwtest/device/modem.asp, before you pretest any of your products.

Multifunction Devices

If your test device implements more than one functionally independent, logical device, you must test each device with the corresponding WHQL test procedures. For example, a keyboard containing a Trackball mouse or Touch pad must be tested against both the Keyboard Compatibility Tests and the Input Pointing Tests. These tests are found in the Keyboard and Input/Pointing Drawing Presubmission Test Procedures.

You must include completed Test Procedures and test logs for each logical device function (available at http://www.microsoft.com/hwtest/) and the Multifunction Device Supplement (downloaded with this document) with your Self-Test Submission

Use Microsoft Word for Windows( software (English language version) to fill out this document. You can conveniently navigate to each field using the Tab key or by pressing the Shift and Tab key combination. You must include an electronic copy of this completed document with your Self-Test Submission for each device you test. Also include device driver files, .INF files, log files, and utilities (if any). Please virus check all files sent to WHQL.

Please complete all tests, and provide supporting documentation and comments where requested. If a test is not applicable, mark it as N/A. This document automatically generates a test summary, based on your test information.

Warning
You must copy the WHQL.dot to the same location 
as the Normal.dot on your computer in order for the Test Summary 
section to update as you complete the Test Procedures section.

Test Tools and Equipment

The following equipment is needed to perform these test procedures.

Hardware

You need the following hardware equipment to perform these test procedures. For specific reference hardware version information, go to the Modem FAQs at: http://www.microsoft.com/hwtest/device/modem.asp

· Test modems: two (2).

· Special jack/phone cables to connect modem to phone line and/or cellular phone.

· Reference modems used in AT command set tests:
· USR Courier V.Everything™ Modem (Reference modem).

· Courier I-Modem running V.90 code

· Ascend MAX 1800 running V.90 code.

· Analog phones: two (2) used in Application Compliance tests.

WHQL expects all modem test submissions to pass testing against the reference hardware listed above. WHQL sends you a test report with a fail result if your device does not pass testing on the reference hardware.

· Annapolis Micro Systems, Inc. FOXFIRE™ II PCI Adapter Card. 
This card can be ordered from the PCI Special Interest Group web site at http://www.pcisig.com.
· Test Computers

· System that ships with this modem

Software

You need the following software to perform these test procedures:

· Microsoft Windows Logo Hardware Compatibility Test Kit version 9.6 (or later) test tool CD. 
Go to http://www.microsoft.com/hwtest/testkits/order.asp to order the HCT 9.6 CD. This CD is also provided through the Microsoft Developer’s Network (MSDN) Call 1-800-759-5474 to enroll in MSDN or visit the web site at: http://msdn.microsoft.com/.

· Modem Developer’s Kit (MDK), which is with the appropriate OS development kit that can be downloaded from available at http://www.microsoft.com/hwdev/.

· Profile Calculator provided with the MDK.

· Microsoft( Modem Event Log software provided with the MDK.

· Microsoft( Windows( Millennium Edition operating system.

· Microsoft Word for Windows( 97 or later software to fill out the document.
· All vendor-supplied Windows applications.

Other

You need the following other equipment to perform these test procedures:

· Printout of the test modem’s .INF file.

If you have any questions relating to DDK, device development, or driver development, or Modem .INF Development contact Microsoft Technical Support at 1-800-936-5800 and check the web site at http://support.microsoft.com/support/ddk_hardware/. If you have other questions, contact WHQL by e-mail whqlinfo@microsoft.com.

Test System Configuration for AC97 Modem

The following section includes system configuration instructions you must complete before testing your modem device. 

Verifying that Windows Millennium Edition Installed in ACPI Mode

You must use an ACPI-capable test system to pass the Windows Logo Hardware Compatibility Test Kit version 9.6.
To determine if the operating system installed in ACPI mode

1. Click Start > Settings > Control Panel.

2. In the Control Panel, double-click System.

Note:
If you do not see the System option in the Control Panel, click view all Control Panel options to display the System icon.

3. In the System Properties dialog, click the Device Manager tab.

4. Click the View devices by connection option.

5. If Advanced Configuration and Power Interface (ACPI) BIOS appears, the operating system installed correctly in ACPI mode. You can install the Windows Logo Hardware Compatibility Test Kit version 9.6 test tool and run the tests.

6. If Plug and Play BIOS appears, the operating system did not install in ACPI mode. You must reinstall the Windows Millennium Edition operating system in ACPI mode.

To install Windows Millennium Edition in ACPI mode

To force-install Windows Millennium Edition in ACPI mode, use a Windows Me, Windows 98, or Windows 98 SE Startup Disk. 

1. Insert the Windows Millennium Edition CD in your test system’s CD ROM drive.

2. Insert the Startup Disk into drive A.

3. Reboot the test system. 

4. When the Startup menu appears, select the Start with CD-ROM support option.
The test system boots into command mode and displays the drive letter of the CD-ROM drive.

5. At the A: prompt, enter the driver letter of the CD-ROM drive on your test system that contains the Windows Me CD. 

6. To install Windows Me in ACPI mode, enter the following: setup /p j
Note: You must enter a space between p and j for proper ACPI mode installation.

7. Follow the on-screen instructions to install Windows Me in ACPI mode.

To install the FOXFIRE™ II PCI Adapter Card 

This section requires that you install the Annapolis Micro Systems, Inc. FOXFIRE™ II PCI Adapter Card prior to installing the WHQL HCT 9.6 test suite on Windows Me. If the test system has more than one PCI slot, install the FOXFIRE II adapter into the zero. You can find the PCII Adapter Card at http://www.pcisig.com.
Note:
Do not use the New Hardware Found Wizard to install the FOXFIRE II Adapter card. The HCT 9.6 installs all drivers.

To install the Windows Hardware Compatibility Tests (HCT 9.6)

You must install the HCT 9.6 on both the server machine first, and then the client machine.

1. Insert the Microsoft Windows Logo Hardware Compatibility Test 9.6 (HCT) test tool CD into the CD-ROM drive.

2. Open the HCT folder, and then double-click the HWTest.exe file.

3. At the Microsoft Windows Hardware Compatibility Tests window, click System/Device Hardware Compatibility Tests.

4. At the Startup window, Install To text box, enter the appropriate destination location for your HCT file (for example, C:\HCT), and then click OK.
The system supplies the correct default paths for the Test Binaries Loc text box, and the Update Binaries Loc text. 

5. On the server machine, Tester Type window expand Device, select the appropriate device type you want to test, select Server Tools, and then click Continue.

a. At the product Identification dialog box, enter the Product Name with the name of your test or server device, as you want it to appear on the HCL, and then click Continue.

b. At the System Configuration dialog box, click the following buttons to complete the required information, and then click Continue.

· System

· Processors

· Video

· I/O

· Network

· MultiMedia

6. On your client machine, repeat steps 5a-5b, but select the appropriate test modem device name from the device tree.

7. After you complete the installation, the system displays the Test Manager window.

Running the Modem Hardware Compatibility Tests
In the Test Manager window, select and start the following tests. WHQL recommends that you run the HCT 9.6 tests in the following order:

	Signability Test

	Disabler (PCI Modem)

	Device Viewer/PCI Test

	Modem Compatibility Tests

	Wake on Ring Test

	Modem D3 Test


1.0
Windows Millennium Edition, Modem Installation

This section is designed to make sure that the test modem is compliant with PCI Plug and Play. It is understood that end users are not suppose to install these devices. However, it is likely that some will remove and then add it in again. Since it is exposed to the operating system as a PCI function, the installation should occur as expected. It approaches the installation process from an end user standpoint and tries to incorporate the end user’s expectations.

To test the modem installation

1. Verify that Windows Millennium Edition is installed. 

2. Install the test modem by inserting the test modem into an open PCI slot. 

3. Connect the phone cable to the appropriate jack on the test modem, it should be labeled clearly if there is more than one option. 

4. Turn on the reference computer.

5. Verify that the system displays the Add New Hardware Wizard and requests to search for new drivers for a PCI Communication Device.

6. Click Next, and then select the Search for the best driver for your device (Recommended) option.
7. Click Next, specify the correct drive or location for the drivers, and then insert the correct driver disk.

8. For Plug and Play compliance, verify that the computer did not reboot or request a reboot after installation.
It is acceptable if the system requests a reboot to add support for a DOS-based application as long as the test modem functions under Windows without rebooting.

9. At the Start menu, click Settings > Control Panel > Modems > Diagnostics, select the test modem, and then click More Info.

10. Verify that the test modem is functional, click Phone Dialer, and enter a number of a local phone that you can hear ring. 

11. Place the call. 

Did the test modem pass all of the Plug and Play tests without errors?
 FORMDROPDOWN 

Comments:      
2.0
Hardware Device IDs

PCI IDs are one of the most important aspects of a Plug and Play device. A proper PCI ID is presented in the following format; PCI&VEN_yyyy&DEV_xxxx&SUBSYS_xxxxyyyy. The SUBSYS id comprises of a device ID and Vendor ID in that order.  The PCI SIG supplies both sets of vendor IDs within the PCI ID, while the device ID is supplied by a manufacturer or OEM. For more information concerning PCI IDs contact the PCI SIG at www.pcisig.com, or Ref - Special Interest Group, PCI Local Bus Specification, revision 2.1 June 1, 1995, page 188. 

To determine that the IDs for the test device are implemented correctly 
1. At the Test Manager window, expand Device > Modem > Self Test > PCI, select Device Viewer/PCI to determine what the PCI ID is for the test modem as specified on the card. 

2. Click Add, and Start. 
After the test has finished the system displays the Test Results window. 

3. Select PCI 2.1 (Class 7 –Modems), and click Details. 
The following example describes the log with the PCI IDs sections color-coded. 

Beginning test of device : Unknown Device

Bus: 0x000, Device: 0x014, Function: 0x000

Reading the PCI Card's Config Space...

Vendor ID: 0x127A, Device ID 0x2015
Class Code: 0x07, SubClassCode: 0x80, P/F 0x00

Verify that the Vendor ID is not zero or 0FFFFh (127a)...PASS

Verify that the Subsystem Vendor ID is not zero nor 0xFFFF (14d4)...PASS

Verify that the Subsystem Device ID is not zero nor 0xFFFF (2015)...PASS 

4. Use the information in the previous log, to extract the PCI ID.
Here is the extracted PCI ID for the previous PCI 2.1 Compliance test log. 

PCI&VEN_127A&DEV_2015&SUBSYS_201514D4 

Please provide the following information for your test modem:

What is the PCI ID taken from the card?
PCI\VEN_8086&DEV_2446&SUBSYS_14661043
Comments:      
To determine the PCI ID in the test modem INF

1. Insert the installation disk into the appropriate drive, and then open the file.

2. Navigate to the modem installation files, and then open the modem INF.

3. In the View menu, select Folder Options, and verify that you have selected all files. 
Following is an example of how the system finds the ID in the INF. WHQL recommends that you not include the REV ID in the INF.

[Models]

%ModemName%=DEVICE1, PCI&VEN_yyyy&DEV_xxxx&SUBSYS_xxxxyyyy

Please provide the following test modem information.

Does the ID in the .INF match the ID taken from the test modem?
 FORMDROPDOWN 

Comments: %String5%=PCtelWDM1,PCI\VEN_8086&DEV_2446&SUBSYS_14661043

the ID can be found under [PCtel] in pctwdm.inf

3.0
Windows Millennium Edition, Hardware Compatibility Test (HCT 9.6)

This section includes the HCT 9.6 test procedures for the AC 97 modem. You must complete the following tests in the HCT 9.6, when testing the AC 97 modem installed in the Windows Millennium Edition operating system.

General Instructions:

These tests require that you install the Microsoft Windows Logo Hardware Quality Tests version 9.6 (or later) test tool on two (2) different computers. WHQL refers to the computer with the test modem as the "client" and the computer that has the V.Everything™ installed on it as the "server". Verify that the two computers can detect each other across a TCP/IP network. To verify this connection, confirm that you can successfully run the PING command. Typically, this test fails to run due to the NetBEUI protocol functioning, therefore the two computers appear properly networked; however, they are not successfully using a TCP/IP, which this test requires. 

Additional Logging And Troubleshooting (optional):

· Use the modem event log to troubleshoot modem connection problems, and to find any possible missing response codes in the .INF file. This utility displays everything sent to the modem, and the modem’s responds.

· If the log ever shows an unrecognized response message, then verify that the INF includes the appropriate response code. If the INF does not include the appropriate response code, then your modem receives a failed test submission.

· Install the modem event log on all machines. Include the test machine, and all reference machines you use.

1. Copy LOGWIN.exe from the MDK into the Windows, Desktop folder.

2. Click the Start menu, expand Settings, and then select Control Panel.

3. Double-click the Modems icon, click the General tab, and then click Properties.

4. Click the Connection tab, and then click Advanced.

5. Under Advanced Connection Settings, select the Record a Log File option, and then click OK.

6. Click Start, and then select the Run icon.

7. Run LOGWIN.exe to display the LOGWIN window. 
When you run the HCT Test Manager during the following procedures, the modem event log data appears in the LOGWIN window, and stores the data in the log file (MODEMLOG.txt), located in the \Windows folder.

WHQL recommends that you perform the following HCT 9.6 full-tests in the following order:

To run the AC97 Full Tests

1. At the Test Manager window, select the following tests from the device tree in the left pane, and then click Add, and Start.

· Signability
This test examines the modem compatibility for digital signatures. WHQL developed a stand-alone application that you can use to test your INFs for errors before you send your driver files to Microsoft for digital signing. This application is now incorporated into the HCT, for all test kits.

· Disabler Test

2. Click View Results for test result information.

To run Device Viewer/PCI Test

This test verifies that the device modem implements the required Power Management states. Specifically, Device Viewer requires that you can place the modem in the D3 and D0 states.

1. At the Test Manager window, expand Device > AC 97 Modem Full Test, select Device Viewer/PCI Test, and then click Add, and Start.

2. At the Device Viewer window, select the name of your test modem, in the right pane locate the Power State, and then verify the current power state of the modem.

3. At the DevNode menu, and then select a different power state. 
For example, if the modem is currently in the power state of D0, select the Power State D3 option. Or, if the modem is currently in the power state of D3, select the Power State D0 option.
4. At the Options menu, select Refresh.

5. In the right pane, locate Power State, and verify the current power state of the modem.

6. At the DevNode menu, select the original power state.

7. At the Options menu, select Refresh.

8. In the right pane, locate Power State, and verify the current power state of the modem.

9. To run the PCI portion of this test, repeat steps 1-8, to place the test modem in a D0 power state.

10.  Verify that the system automatically performed the PCI portion of the test.

To run the Modem Compatibility Tests (MCT) 

This section examines the AT command set provided by the test modem’s .INF file. The test modem must provide an AT command set compatible to the AT commands, documented in the TIA-602 specification. WHQL compares the test modem’s command set against a 3Com Courier V.Everything™ modem with the INF downloaded from the Modem FAQ on http://www.microsoft.com/hwtest/device/modem.asp
.
Verify the following setup information, before running the MCT:

· Determine that the test modem is installed on a valid test computer and has a fully functional HCT 9.6 test suite installed.

· Determine the 3Com Courier V.Everything™ modem with the INF downloaded the Modem FAQ on http://www.microsoft.com/hwtest/device/modem.asp
 is installed on a server computer that has the HCT 9.6 installed.

1. On the server machine start the HCT 9.6.

2. At the Tester Type window expand Device, select Server Tools, and then click Continue.

3. At the System Configuration window verify the required information, and then click Continue.

4. At the Test Manager window expand Device > Modem > Server Tools, select Modem Compatibility Test (Server), and then click Add and Start.

5. At the MCT Server window, Modem tab, select the server modem, and then click Properties.

6. Verify that the phone number is correct, and that the client and server machines detect each other over a TCP/IP network.

7. On the client computer start the HCT 9.6.

8. At the Test Manager window, left pane device tree, expand Device > AC 97 Modem Full Test, select Modem Compatibility Tests, and then click Add and Start.

9. At the MCT Startup Parameters dialog box, complete all of the information, and then click Query Server.
The system displays all of the modems installed on the sever machine.

10. Select the appropriate server, and then click OK.

11. Run all of the tests available in the Modem Compatibility Tests suite against the 3Com Courier V.Everything™, and then click View Results.

To run the Wake On Ring Test

1. On the server machine expand Test Manager window, expand Device > Server Tools, and select the Wake On Ring Test (Server), and then click Add and Start. 

2. At the Wake-up call manager window, click the Settings menu, and then select Options.

3. Verify that the phone number is correct.

4. On the client machine, Test Manager window, expand Device > AC 97 Modem Full Test, select Wake On Ring Test (Test Modem), and then click Add and Start.

5. At the Dozer Settings dialog box, complete the Server Name and Telephone Number text boxes only, and then click OK.

6. Click View Results to examine test result information.

To run the Modem D3 tests

Modem device test verifies whether the PCI modem devices and drivers support D0 and D3 power states per Default Device Class PM specification. This test also verifies whether these devices generate PME# event from D3 Cold device state.

1. At the Test Manager window expand Device > AC 97 Modem Full Test, select Modem D3 Test, and then click Add and Start.

2. At the AC97 D3 Test dialog box, click Yes if the Fox Fire card is installed on your system.

3. At the Suspend/Resume Switch Test dialog box follow the instructions, and the complete information for the manual tests, and then click OK.

4. Click View Results for test result information.

To view test results and submit the HCT 9.6 Test Completion Logs

After you complete the HCT 9.6 tests, you must determine if any of the tests failed. 

1. At the Test Manager window, click View Results. 
The middle column displays a Pass, Fail, or Not Run message. 

2. Select one or more tests, and click on Details.
You can view the content of each log file. Use the navigation buttons to search for warnings, failures, or specific text.

3. When you complete the tests, click Return Test Results from the Test Manager menu.

4. Insert a disk into the appropriate drive, select the appropriate drive, and then click Copy Logs.

5. You must submit these logs to WHQL for auditing.

4.0
Windows Millennium Edition, Remote Dial-up Network Compliance

This test verifies that the Test modem functions properly as a Client of the Dial-up Networking functionality built into Windows Millennium Edition. This test requires two (2) machines: a test computer for the Test modem and a Server machine set up as a Remote Access Computer with an Ascend Max and 3Com I-Modem installed and connected to ISDN lines.

To test the dial-up connection

1. Verify that the Dial-up Networking is installed on the client test computer.

2. Verify that the server is configured correctly, and that it has a shared directory named DUN Test, which includes the Mini.cab file.

3. At the Client machine desktop, double-click on the My Computer icon, and then double-click Dial-up Networking.

4. Double-click on the Make A New Connection icon, and then create a connection (with the server) titled DUN Test.

5. Select the test modem, and then enter the phone number of the Ascend Max attached to the RAS server.

6. Double-click the DUN Test connection, enter the User ID and Password for the server, and then click Connect to connect to the server.

7. Note the connection speed.

8. Disconnect from the Ascend Max, and open Dun Test. 

9. Change the phone number to the 3Com I-Modem, enter the User name and Password, and then click Connect.
10. Note the connection speed.

Did the modem connect above 33.6 against the Ascend Max and 
3Com I-Modem?
 FORMDROPDOWN 

Comments: the connection speed of the test modem = 54,666bps
To copy and compare files

1. Navigate to the server’s shared directory containing the Mini.cab file, and then drag-and-drop the file to any local directory. 
This file should take between 5 and 10 minutes to transfer over a 28.8 kbps link. 

2. Compare the file on the server to the file that you downloaded.

3. At the Windows Millennium Edition CD, use a program, such as WinDiff, to compare the mini.cab files on the client and server PC systems. 

4. Click on the File menu, and then select Compare Files.

5. Enter the first location to the downloaded Mini.cab file, and then the second location to the original Mini.cab.

6. Verify that the file compare program (or equivalent program) reports the files as identical.
You can have a different date or time stamp.

Was the Mini.cab copied, and are the two Mini.cab
files identical?
 FORMDROPDOWN 

Comments: the time of copying mini.cab via the test modem was about 3:00 minutes.    WinDiff reported that the size of the copied mini.cab = the size of the original one on the server, which is 686,042bytes


5.0
Windows Millennium Edition, Multilink Test 

This section verifies that the test modem functions properly as a client of the Dial-up Networking Multilink functionality built into Windows Millennium Edition. This test requires two (2) machines: a test computer for the test modem and a server machine set up as a Remote Access Computer with an Ascend Max and 3Com I-Modem installed and connected to ISDN lines. 

To test the multilink functionality

1. Verify that one of your test modems installed on the client test machine.

2. Verify that your test machine has a Courier V.Everything™ modem installed.

3. Verify Dial-up Networking is installed on the client test machine.

4. Verify that the server is configured correctly, and that it has a shared directory named DUN Test, which includes the Mini.cab file.

5. At the client machine desktop, double-click the My Computer icon, and then double-click the Dial-up Networking icon.

6. Double-click the Make A New Connection icon, and create a connection (with the server) titled DUN Test.

7. Select the test modem, and then enter the phone number of Ascend Max attached to the RAS server.

8. Right-click on the DUN Test icon, and then select Properties.

9. Click on the Multilink tab, select Use Additional Device, and then click Add.

10. Select the Courier V.Everything™ modem from the list, enter the phone number of the 3Com I-Modem, and then click OK.

11. Double-click on the DUN Test connection, enter the User ID and Password for the server, and then click Connect to dial the server. 

Are you connected to the server with both modems? 
 FORMDROPDOWN 

Comments: the connection speed = 109,200bps
12. At the Mulitilink tab, change the call order of the two modems.
It does not matter which modem connects first.

Can you connect to the server with the test modem calling first? 
 FORMDROPDOWN 

13. Comments: regardless of which modem connects first, the second one was always bundled in Multilink
14. Repeat steps 1-12 using the machine with the Courier V.Everything™ modem.

Can you connect to the server with the V.Everything™ modem calling first? 
 FORMDROPDOWN 

To copy and compare files

1. Navigate to the server’s shared directory containing the Mini.cab file, and then drag-and-drop the file to any local directory. 
This file should take between 5 and 10 minutes to transfer over a 28.8 kbps link. 

2. Compare the file on the server to the file that you downloaded.

3. At the Windows Millennium Edition CD, use a program, such as WinDiff, to compare the mini.cab files on the client and server PC systems. 

4. Click on the File menu, and then select Compare Files.

5. Enter the first location to the downloaded Mini.cab file, and then the second location to the original Mini.cab.

6.  Verify that the file compare program (or equivalent program) reports the files as identical.
You can have a different date or time stamp.

Was the Mini.cab copied, and are the two Mini.cab
files identical?
 FORMDROPDOWN 

Comments: the time of copying mini.cab was about 2:00 to 3:00 minutes and WinDiff reported that the size of the copied mini.cab is identical to the size of the original on the server
6.0
Windows millennium Edition, Modem Uninstallation 

To comply with Windows compatibility, your test modem must have a clean and intuitive modem removal process.

To test the modem uninstallation

1. To test your modem removal process, remove the modem from your system.

How is the test modem removed? 
 FORMDROPDOWN 

Are there instructions explaining how or where the modem is removed?
 FORMDROPDOWN 

Comments: refer to the Modem Installation Guide  attached in submission.


2. Uninstall the test modem using the appropriate method as specified in step 1.

3. To verify that the test modem was successfully removed, expand the Start menu, Settings Control Panel, select Modems, and then verify if your modem appears in the list.

Did uninstalling the test modem remove it from the Modem list?
 FORMDROPDOWN 

Comments:       

4. If the modem is implemented as a riser card then continue to step 5.

5. Uninstall the modem drivers.

6. Turn off the machine, and physically remove the modem riser card.

7. Restart the machine, and allow Windows to start. 

8. Check the Device Manager menu to verify that the test modem is not listed. 
If the test modem is listed in Device Manager menu, the BIOS is not properly disabling the PCI function. This is likely caused by the BIOS improperly implementing a detection algorithm to verify that the appropriate modem codec is present before enabling it.

Did the BIOS disable the modems PCI function when the riser card was removed?
 FORMDROPDOWN 

Comments:      


7.0
Windows Millennium Edition, Upgrade to Windows 2000

Perform the upgrade test to support a smooth driver transition between two Windows operating systems.

To test the upgrade to Windows 2000

1. Verify that the test modem is installed and functional under Windows Millennium Edition. 

2. Follow the instruction to upgrade the operating system to Windows 2000 Professional. 

3. Specify the location of the modem driver Upgrade Pack if prompted.

4. After you complete the upgrade, verify the test modem is working by using the Phone Dialer to make a call.

Did the Test Modem work after the computer was upgraded to Windows 2000?
 FORMDROPDOWN 

Comments:      
Please indicate that the test device has completed all test procedures.
 FORMCHECKBOX 
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